Thank you for buying a Pentax Digital Camera.

This is the manual for “PENTAX PHOTO Browser” and “PENTAX PHOTO Laboratory”, software for your Windows PC or Macintosh for enjoying images created with your camera. Please read the separate camera operating manual and this manual before using your camera, “PENTAX PHOTO Browser”, or “PENTAX PHOTO Laboratory”, in order to get the most out of all the features and functions. Keep the camera operating manual and this manual safe, as they can be valuable tools in clarifying and helping you to understand all the camera’s capabilities.

Regarding trademarks
CompactFlash and CF are trademarks of SanDisk Corporation. Adobe Acrobat Reader is a trademark of Adobe Systems, Inc. PENTAX is a trademark of PENTAX Corporation. PENTAX PHOTO Browser and PENTAX PHOTO Laboratory. PENTAX REMOTE Assistant are trademarks of PENTAX Corporation. All other brands or product names are trademarks or registered trademarks of their respective companies.

Provided software
The provided CD-ROM (S-SW10) contains the following software:
- PENTAX PHOTO Browser
- PENTAX PHOTO Laboratory
- Adobe Acrobat Reader
- Manual (PDF file)

Symbols used in this manual have the following meanings:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>📃</td>
<td>Gives page numbers explaining related operations.</td>
</tr>
<tr>
<td>📉</td>
<td>Gives information that is useful to know.</td>
</tr>
<tr>
<td>🚨</td>
<td>Gives cautions and notes about the operation.</td>
</tr>
</tbody>
</table>

The screen pictures shown in this manual may differ depending on the type of computer used.
Here are some ways to use the images captured with your digital camera.

### Use your monitor

Connect your camera to a TV with an AV cable to enjoy your pictures on the screen.

*“Digital Camera *ist D* Operating Manual” (p.130)*

### Use your photo shop

Have prints made from your card images at a photo shop.

- Set DPOF settings on your camera, and get prints from your photo shop. *Camera Operating Manual*
- Select the images for prints.

### Is your computer...

- equipped with a standard USB interface?
- using Windows Me/2000/XP as your OS?
  Or Mac OS 9/X?

#### Connect your camera and computer with a USB cable, and copy the entire folder of camera images to your computer.

#### Is your computer...

- using Windows 95/98/NT, Mac OS 8.6, or an earlier OS?

#### Transfer your images using a built-in card slot + PC card adaptor or a card reader.
Use your image data

Use your e-mail software to attach images to e-mails, or use them on your homepage.
- See the operating manual of your e-mail software for details on how to make attachments to emails.
- See the operating manual of the software you are using for details on how to use images on your homepage.

Use your printer

Use commercially available image software to print images from your computer to your printer. Some printers can print directly from cards.
- For details, see the operating manual of the software or printer you are using.

Images sent to the computer can be saved onto a CD-R or other media.

Regarding copyrights

Images taken using the *ist D that are for anything other than personal enjoyment cannot be used without permission according to the rights as specified in the Copyright Act. Please take care, as there are even cases where limitations are placed on taking pictures even for personal enjoyment during demonstrations, industrial enterprise or as items for display. Images taken with the purpose of obtaining copyrights also cannot be used outside the scope of use of the copyright as laid out in the Copyright Act, and care should be taken here also.
PENTAX PHOTO Browser is software for viewing and managing images taken on your digital camera and saved on your computer. When you select a folder containing saved images, PENTAX PHOTO Browser compatible images in the folder automatically appear as thumbnails. You can select a thumbnail image to view an image. (Files with extensions [.PEF (RAW)], [.TIF (TIFF)], and [.JPG (JPEG)] are supported)

PENTAX PHOTO Browser also does the following tasks:
• Save image files under a new name, change file names, copy, cut, delete and paste.
• Create new folder, change folder name, copy, cut, delete and paste.
• Save Image Data List
• Check Image Data
• View RAW image data easily.

You can also start RAW image data editing software PENTAX PHOTO Laboratory and camera control software PENTAX REMOTE Assistant from within PENTAX PHOTO Browser.

**PENTAX PHOTO Laboratory**
Performs color separation processing and other processing on CCD RAW image data recorded in PENTAX digital camera dedicated format, enabling them to appear on commercially available image viewing and editing software.

**PENTAX REMOTE Assistant**
This software has an additional function that controls the camera from a computer. To use PENTAX REMOTE Assistant, you will need to purchase and install PENTAX REMOTE Assistant separately. (Available soon)

PENTAX PHOTO Laboratory and PENTAX REMOTE Assistant can also be run as standalone applications.
System Requirements

We recommend the following system requirements to install and use PENTAX PHOTO Browser.

For Windows

- **OS:** Windows Me / 2000
  Windows XP Home Edition / Professional
- **CPU:** Pentium III or later recommend
- **Memory:** 256MB or more
- **Monitor:** 1024 × 768 in 24 bit full color
  (approx. 16.77 million colors)
- **Free Disk Space:** 70MB or more
- **USB port must be standard equipment.**

Caution
- In Windows 95/98/NT, you cannot conduct file transfers via a USB cable or use PENTAX REMOTE Assistant.
- We recommend using the AC adapter D-AC10 when the camera is connected to the PC. If the batteries become depleted during image transfer, image data, the CF card or the micro drive may be damaged.

For Macintosh

- **OS:** Mac OS 9.0 or high (CarbonLib 1.5 or later)
  Mac OS X 10.1.3 or later
- **CPU:** Power PC G3 or later
- **Memory:** 256MB or more
- **Monitor:** 1024 × 768 in 24 bit full color
  (approx. 16.77 million colors)
- **Free Disk Space:** 70MB or more
- **USB port must be standard equipment.**

Caution
- We recommend using an AC adapter D-AC10 when the camera is connected to the PC. If the batteries become depleted during image transfer, image data, the CF card or the micro drive may be damaged.
- In Mac OS 8.6, you cannot conduct file transfers via a USB cable or use PENTAX REMOTE Assistant.
Installing the PENTAX PHOTO Browser

Here is the procedure for installing PENTAX PHOTO Browser. PENTAX PHOTO Laboratory is automatically installed when PENTAX PHOTO Browser is installed.

Login as the administrator before installing on Windows 2000 / XP or Mac OS X.

### When using Windows

1. **Turn on your PC.**
   
   Close any other software that is open.

2. **Place the provided CD-ROM (S-SW10) into the CD-ROM drive on your PC.**
   
   Select your applicable language and click [OK] when the language setting screen is appeared.

3. **The installer starts. Click [Next].**

   Some operating environments select the language automatically. If so, the installer in 3 will start. Continue with the installation.
4 Confirm that the folder name to install. Click [Next].

5 Confirm that the group name to register in the start menu. Click [Next].

6 Confirm file copy. Click [Next].

Start copying the file.

7 The completion message appears after installing the software is finished. Click [Finish] to quit the installation program.
When using Macintosh

1. Turn on your Macintosh.
   Close any other software that is open.

2. Place the provided CD-ROM (S-SW10) into the CD-ROM drive on your Macintosh.

3. Double-click the [CD-ROM (S-SW10)] icon.
   The contents of the CD-ROM are displayed.

4. Double-click your applicable language.

5. Double-click the [PENTAX Installer] icon.
   The selected language installer starts.

6. When [Installation was successful....] appears. Click [Quit].
Here is the procedure for saving images captured with your digital camera onto your computer. This section describes the method for saving images by connecting your camera and PC with the USB cable, as well as other methods.

### Saving images by connecting your camera and PC (using Windows)

#### Connecting your camera to your PC

1. **Turn on your PC.**

2. **Turn off your camera and use the USB cable to connect your camera and your PC.**
   Confirm that a CF card is inserted into your camera.

#### Turn on your camera.

The camera is recognized as a [Removable Disk] under [My Computer].

---

*Memo*

When using Windows XP, if the CF card has a volume label, the content of the volume label name appears instead of [Removable Disk]. The manufacturer name or model number may appear on new unformatted CF cards.
Saving camera images on your PC

1 Double-click the [My Computer] icon on your PC Desktop.
   For Windows XP, this is in the [Start Menu].

2 Double-click the [Removable Disk (F:)] icon.

3 Double-click the [DCIM] icon.
   The [XXXPENTX] (XXX is a three-digit number) folder appears.
   The camera image files are in this folder.

4 Drag and drop the [XXXPENTX] folder into any desired folder, such as the PC Desktop or the [My Documents] folder.
   The camera images are saved on your PC as an entire folder.
Disconnecting your camera from your PC

Windows Me / 2000

1. Double-click the (hot plug icon) on the status bar at the lower right of the Desktop.
   The [Unplug or Eject Hardware] screen appears.

2. Confirm that [USB Mass Storage Device] is selected and then click [Stop].
   The [Stop a Hardware Device] screen appears.

3. Select [USB Mass Storage Device] and click [OK].
   A message box appears.

4. Click [OK].

5. Turn off the camera and disconnect the USB cable from your camera and PC.

   The USB mass storage device will not stop when applications or other files stored on the removable disk are in use.
1. Double-click the [Safely Remove Hardware] icon on the task bar.
   The [Safely Remove Hardware] screen appears.

2. Confirm that [USB Mass Storage Device] is selected and then click [Stop].
   The [Stop Hardware Device] screen appears.

3. Click [USB Mass Storage Device] and click [OK].
   A message box appears.

4. Turn off the camera and disconnect the USB cable from your camera and PC.
Saving images by connecting your camera and Macintosh (using a Macintosh)

Connecting your camera to your Macintosh

1. Turn on your Macintosh.

2. Turn off your camera and use the USB cable to connect your camera and your Macintosh.

   Confirm that a CF card is inserted into your camera.

   ![Connecting camera to Mac](image)

3. Turn on your camera.

   Your camera is recognized on the desktop as [Untitled (the volume label of the CF card if one is registered)]. You can change the folder name.

   ![Memo](image)
   For Mac OS X, it is recognized as [No_NAME] (the volume label of the CF card if one is registered).
Saving camera images on your Macintosh

1 Double-click the [Untitled] or [NO_NAME] icon on the Desktop.

2 Double-click the [DCIM] icon.
   The [XXXPENTX] (XXX is a three-digit number) folder appears.
   The camera image files are in this folder.

3 Double-click the [Hard Disk] icon on the Desktop.
   This opens the [Hard Disk] folder.

4 Drag and drop the [XXXPENTX] folder into the [Hard Disk].
   The camera images are saved into the [Hard Disk] folder as an entire folder.
Disconnecting your camera from your Macintosh

1 Drag [NO_NAME] (or the CF volume label name if available) on the Desktop to the trash can.

2 Turn off the camera and disconnect the USB cable from your camera and Macintosh.

Other methods for saving images

Use a card reader or card adapter to send image files directly to your computer from a card with saved images without connecting your camera and your computer with a USB cable. For details, please refer to the user's manual for your computer or card reader.
This section describes opening and closing PENTAX PHOTO Browser and viewing the PENTAX PHOTO Browser window, and explains its functions.

## Opening the PENTAX PHOTO Browser

### For Windows


2. Select [PENTAX PHOTO Browser] from the [PENTAX Digital Camera Utility] in the [program menu].

   PENTAX PHOTO Browser is opened and the PENTAX PHOTO Browser window appears.

### For Macintosh


2. Double-click the [PENTAX PHOTO Browser] program icon.

   PENTAX PHOTO Browser is opened and the PENTAX PHOTO Browser window appears.

### Closing PENTAX PHOTO Browser

Select [Quit Application].

---

To open [PENTAX PHOTO Browser], you need to install [PENTAX PHOTO Browser] on your computer. See “Installing the PENTAX PHOTO Browser” on P.6 for the installation procedure.
This section explains the PENTAX PHOTO Browser window layout, names and functions.

- **Tree view**
  Internal data on your computer appears here as a folder tree. Select the folder containing saved image files here. Also, the tree view handles operations such as creating new folders, erasing folders or moving/copying folders. (Applies only to Windows)

- **Thumbnail pane**
  Images in the folder selected in the tree view appear here as thumbnails. The size of thumbnails can be selected from four sizes. When a thumbnail image is selected in the thumbnail pane, the image appears in the preview pane and the image data appears in the image data pane.

- **Preview pane**
  An image selected in the thumbnail pane appears in this view.
• **Image data pane**

The image information for the image selected in the thumbnail pane appears here.

The following items appear:

<table>
<thead>
<tr>
<th>Lens name</th>
<th>Recorded pixels</th>
<th>Contrast</th>
</tr>
</thead>
<tbody>
<tr>
<td>Focal length</td>
<td>Quality</td>
<td>Drive mode</td>
</tr>
<tr>
<td>Shutter speed</td>
<td>Exposure compensation</td>
<td>Flash mode</td>
</tr>
<tr>
<td>Aperture</td>
<td>Autofocus mode</td>
<td>Bracket</td>
</tr>
<tr>
<td>Capture mode</td>
<td>Autofocus area mode</td>
<td>Multi-exposure</td>
</tr>
<tr>
<td>Metering mode</td>
<td>Color space</td>
<td>Firmware version</td>
</tr>
<tr>
<td>White balance</td>
<td>Saturation</td>
<td>Date/Time</td>
</tr>
<tr>
<td>Sensitivity</td>
<td>Sharpness</td>
<td>Camera name</td>
</tr>
</tbody>
</table>

---

**Menu bar**

This executes functions or sets various settings of the PENTAX PHOTO Browser.

### File menu

<table>
<thead>
<tr>
<th>Create New Folder</th>
<th>This creates a new folder in the location specified on the Tree view. [P.41]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Folder Name</td>
<td>This changes the name of the selected folder. [P.40]</td>
</tr>
<tr>
<td>Delete Folder</td>
<td>This deletes the selected folder. If an image file exists in the folder, the image file will also be erased. Use with caution. [P.39]</td>
</tr>
<tr>
<td>Open Image File</td>
<td>The selected image file appears in the main image view window. [P.23]</td>
</tr>
<tr>
<td>Change Image File Name</td>
<td>This changes the name of the selected image file. [P.40]</td>
</tr>
<tr>
<td>Delete Image File</td>
<td>This deletes the selected image file. [P.39]</td>
</tr>
<tr>
<td>Properties</td>
<td>The properties of the selected image file or folder appear. [P.42]</td>
</tr>
<tr>
<td>Quit Application</td>
<td>This closes PENTAX PHOTO Browser. [P.16]</td>
</tr>
</tbody>
</table>
### Edit menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>This cancels the immediately previous operation on a file or folder, and returns to the status before performing the operation. (You cannot undo delete or name change)</td>
</tr>
<tr>
<td>Cut</td>
<td>This copies the selected file or folder, and deletes the original file or folder.</td>
</tr>
<tr>
<td>Copy</td>
<td>This copies the selected file or folder.</td>
</tr>
<tr>
<td>Paste</td>
<td>This copies the cut or copied file or folder into the currently open folder.</td>
</tr>
<tr>
<td>Select All</td>
<td>This selects all image files within the currently open folder.</td>
</tr>
</tbody>
</table>

### View menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toolbar</td>
<td>Shows or hides the toolbar.</td>
</tr>
<tr>
<td>Image data</td>
<td>Shows or hides the image data pane.</td>
</tr>
<tr>
<td>Thumbnail (Smallest)</td>
<td>The smallest size thumbnail appears in the thumbnail pane. P.22</td>
</tr>
<tr>
<td>Thumbnail (Small)</td>
<td>A small size thumbnail appears in the thumbnail pane. P.22</td>
</tr>
<tr>
<td>Thumbnail (Medium)</td>
<td>A medium size thumbnail appears in the thumbnail pane. P.22</td>
</tr>
<tr>
<td>Thumbnail (Large)</td>
<td>A large size thumbnail appears in the thumbnail pane. P.22</td>
</tr>
<tr>
<td>Optimum Size</td>
<td>The PENTAX PHOTO Browser window size, preview pane, thumbnail pane, and thumbnail size appear at the optimum size for current image resolution settings. P.22</td>
</tr>
</tbody>
</table>

### Tool menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save Image Data List</td>
<td>This saves additional information for all PENTAX PHOTO Browser compatible image files in the currently open folder into one CSV format file. P.33</td>
</tr>
<tr>
<td>PENTAX PHOTO Laboratory</td>
<td>This starts PENTAX PHOTO Laboratory. The applicable image files are specified within the PENTAX PHOTO Browser window. P.44</td>
</tr>
<tr>
<td>PENTAX REMOTE Assistant</td>
<td>This starts PENTAX REMOTE Assistant. (Available soon)</td>
</tr>
<tr>
<td>Options</td>
<td>This sets various settings for PENTAX PHOTO Browser. P.34</td>
</tr>
</tbody>
</table>
### Help menu

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PENTAX PHOTO Browser</td>
<td>The PDF manual appears.</td>
</tr>
<tr>
<td>Help</td>
<td>The version, trademark, etc. for PENTAX PHOTO Browser appear.</td>
</tr>
</tbody>
</table>

### Toolbar

Frequently used functions are provided as toolbar buttons.
You can run these functions easily from the toolbar.

<table>
<thead>
<tr>
<th>Number</th>
<th>Icon (button)</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Back</td>
<td>Opens the folder which was open immediately prior.</td>
</tr>
<tr>
<td>2</td>
<td>Forward</td>
<td>Opens the folder which was open before using the Back button.</td>
</tr>
<tr>
<td>3</td>
<td>Up</td>
<td>Moves to the higher folder.</td>
</tr>
<tr>
<td>4</td>
<td>Undo</td>
<td>This cancels the immediately previous operation on a file or folder, and returns to the status before performing the operation.</td>
</tr>
<tr>
<td>5</td>
<td>Cut</td>
<td>This copies the selected file or folder, and deletes the original file or folder. P.36</td>
</tr>
<tr>
<td>6</td>
<td>Copy</td>
<td>Copies the selected file or folder. P.36</td>
</tr>
<tr>
<td>7</td>
<td>Paste</td>
<td>This copies the cut or copied file or folder into the currently open folder. P.36</td>
</tr>
<tr>
<td>8</td>
<td>Delete</td>
<td>This deletes the selected file or folder. P.39</td>
</tr>
<tr>
<td>9</td>
<td>View Image</td>
<td>The selected image file appears in the main image view window. P.22</td>
</tr>
<tr>
<td>Number</td>
<td>Icon (button)</td>
<td>Content</td>
</tr>
<tr>
<td>--------</td>
<td>--------------</td>
<td>---------</td>
</tr>
<tr>
<td>10</td>
<td>Thumbnail (Smallest)</td>
<td>The smallest size thumbnail appears in the thumbnail pane. P.22</td>
</tr>
<tr>
<td>11</td>
<td>Thumbnail (Small)</td>
<td>A small size thumbnail appears in the thumbnail pane. P.22</td>
</tr>
<tr>
<td>12</td>
<td>Thumbnail (Medium)</td>
<td>A medium size thumbnail appears in the thumbnail pane. P.22</td>
</tr>
<tr>
<td>13</td>
<td>Thumbnail (Large)</td>
<td>Displays a large size thumbnail in the thumbnail pane. P.22</td>
</tr>
<tr>
<td>14</td>
<td>Optimum Size</td>
<td>The PENTAX PHOTO Browser window size, preview pane, thumbnail pane, and thumbnail size appear at the optimum size for current image resolution settings. P.23</td>
</tr>
<tr>
<td>15</td>
<td>PENTAX PHOTO Laboratory</td>
<td>This starts PENTAX PHOTO Laboratory. The applicable image files are specified within the PENTAX PHOTO Browser window. P.44</td>
</tr>
<tr>
<td>16</td>
<td>PENTAX REMOTE Assistant</td>
<td>This starts PENTAX REMOTE Assistant when PENTAX REMOTE Assistant is installed (sold separately).</td>
</tr>
<tr>
<td>17</td>
<td>Options</td>
<td>This sets various settings for PENTAX PHOTO Browser. P.34</td>
</tr>
</tbody>
</table>
Viewing Images

Display the images saved on your computer.

1. In the PENTAX PHOTO Browser window tree view, select the folder containing the image file to view.
Images in the selected folder appear as thumbnails in the thumbnail pane.

You can change the size of the thumbnail image. In the View menu, select [Thumbnail (Smallest)], [Thumbnail (Small)], [Thumbnail (Medium)], or [Thumbnail (Large)]. Or click the button for , , , or on the toolbar.

2 Methods for viewing an image

• In the thumbnail pane, select the image file to view, and then select [Open Image File] in the File menu.
• Select the image file to view, then click on the toolbar in the thumbnail pane.
• Double-click the image file to view in the thumbnail pane.

The main image window will open and the image will appear.
Main image window

- **Menu bar**
  This executes functions or sets various settings of the main image window.

<table>
<thead>
<tr>
<th>File menu</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Save as</strong></td>
<td>When RAW image file is viewed with automatic life size RAW data development, only the image being viewed is saved in Exif-TIFF or Exif-JPEG format. (Cannot be saved when 1:2, 1:4 or Simple display has been selected in the PENTAX PHOTO Browser settings.) [P.34]</td>
</tr>
<tr>
<td><strong>Properties</strong></td>
<td>Image file data appears. [P.32]</td>
</tr>
<tr>
<td><strong>Close</strong></td>
<td>Closes the main image window.</td>
</tr>
<tr>
<td>View menu</td>
<td></td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>----------------------------------------------------------------</td>
</tr>
<tr>
<td>Image data</td>
<td>Shows/hides the image data pane. P.31</td>
</tr>
<tr>
<td>Maintain window size</td>
<td>Interlocks the view magnification of the image size appearing in the image view area with the main image window size. P.29</td>
</tr>
<tr>
<td>Enlarge</td>
<td>Doubles the image view magnification of the image appearing in the image view area. The maximum view magnification is pixels × 4. P.29</td>
</tr>
<tr>
<td>Reduce</td>
<td>Halves the image view magnification of the image appearing in the image view area. The minimum view magnification is pixels × 1/16. P.29</td>
</tr>
<tr>
<td>Life size</td>
<td>Sets the image view magnification of the image appearing in the image view area to life size. P.29</td>
</tr>
<tr>
<td>Optimum Size</td>
<td>Sets the magnification to the maximum size which will allow the entire image to appear in the image view area. P.29</td>
</tr>
<tr>
<td>Rotate Clockwise 90°</td>
<td>Rotates the image appearing in the image view area 90 degrees to the right (clockwise). P.28</td>
</tr>
<tr>
<td>Rotate Counterclockwise 90°</td>
<td>Rotates the image appearing in the image view area 90 degrees to the left (counterclockwise). P.28</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Help menu</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>PENTAX PHOTO Browser Help</td>
<td>The PDF manual appears.</td>
</tr>
<tr>
<td>About PENTAX PHOTO Browser</td>
<td>The version, trademark, etc. for PENTAX PHOTO Browser appear.</td>
</tr>
</tbody>
</table>
• **Toolbar**  
Frequently used functions are provided as toolbar buttons. You can run these functions easily from the toolbar.

<table>
<thead>
<tr>
<th>Number</th>
<th>Icon (button)</th>
<th>Content</th>
</tr>
</thead>
</table>
| 1      | ![Save as](image) | Save as  
When RAW image file is viewed with automatic life size RAW data development, only the image being viewed is saved in Exif-TIFF or Exif-JPEG format. (Cannot be saved when 1:2, 1:4 or Simple display has been selected in the PENTAX PHOTO Browser settings.) P.34 |
| 2      | ![Properties](image) | Properties  
Image file data appears. P.32 |
| 3      | ![Maintain window size](image) | Maintain window size  
Interlocks the view magnification of the image size appearing in the image view area with the main image window size. P.29 |
| 4      | ![Enlarge](image) | Enlarge  
Doubles the image view magnification of the image appearing in the image view area. The maximum view magnification is pixels 4 times. P.29 |
| 5      | ![Reduce](image) | Reduce  
Halves the image view magnification of the image appearing in the image view area. The minimum view magnification is pixels 1/16 times. P.29 |
| 6      | ![Life size](image) | Life size  
Sets the image view magnification of the image appearing in the image view area to life size. P.29 |
| 7      | ![Optimum Size](image) | Optimum Size  
Sets the magnification to the maximum size which will allow the entire image to appear in the image view area. P.29 |
| 8      | ![View Magnification](image) | View Magnification  
The current view magnification appears. You can also set the view magnification by selecting it from a list, or by directly inputting the magnification. P.29 |
| 9      | ![Rotate Clockwise 90°](image) | Rotate Clockwise 90°  
Rotates the image appearing in the image view area 90 degrees to the right (clockwise). P.28 |
| 10     | ![Rotate Counterclockwise 90°](image) | Rotate Counterclockwise 90°  
Rotates the image appearing in the image view area 90 degrees to the left (counterclockwise). P.28 |
• **Image View Area**
The image selected in the thumbnail pane of the PENTAX PHOTO Browser appears.

• **Image data pane**
The image information appears for the image appearing in the image view area.

**RAW image file Simple Display**
PENTAX PHOTO Browser allows you to select between [Simple Display] and [Auto RAW display] when displaying RAW image files in the main image window.  

- Images can be viewed quickly with Simple Display.
- Auto RAW display takes time, but life size images can be saved in Exif-TIFF or Exif-JPEG.

To save images, select [Save as] in the file menu of the main image window; or click the Toolbar and specify [Save in], [Save as type], and [File type], then press [Save].
Rotating the Image View

The image in the image view area appears rotated 90°, 180°, and 270° to the right (clockwise).
Also the image in the image view area appears rotated 90°, 180°, and 270° to the left (counter-clockwise).

1. Select [Rotate Clockwise 90°] or [Rotate Counterclockwise 90°] from the View menu in the main image window.
   Or, click the button in the toolbar.

   The image appears rotated.

![Image view with rotated image]
Changing view magnification

You can change the image view magnification of the image appearing in the image view area.

1  
Select [Maintain Window Size], [Enlarge], [Reduce], [Life Size] or [Optimum Size] from the View menu in the main image window.
Or, click the , , , , or button in the toolbar.
The image view magnification is changed.

Enlarged View
Reduced View

You can also enlarge or reduce the view by directly inputting the numerical value of the magnification in the View Magnification box on the toolbar.
Hiding the image data

You can set whether to show or hide the image data in the main image pane.

1 Select [Image Data] from the View menu in the main image window to uncheck it.

The image data is hidden.

To display the image data pane, select “Image Data” from the View menu in the main image window to put check mark (✓)
Displaying image properties

You can display file data for the image file appearing in the main image window.

1 Select [Properties] from the File menu in the main image window.


2 Confirm the content and input information as needed.

3 Click [OK].

The properties window is closed.

This content is identical to the content displayed when you select a thumbnail image in the thumbnail pane within PENTAX PHOTO Browser, and select [Properties] from the File menu. P.42
Saving a List of Image Data

This saves all additional information for all PENTAX PHOTO Browser compatible image files in the currently open folder, into one CSV format file.

1 Select [Save Image Data List] from the tool menu in the PENTAX PHOTO Browser window.

The [Save Image Data List] dialog box appears.

2 Specify the file name and saving location, and click [Save].

The image data is saved in CSV format.

* memo * When a thumbnail image is selected, only information for the selected image is saved.
Changing the PENTAX PHOTO Browser settings

Here, you can set the PENTAX PHOTO Browser initial settings, such as the initial image view size, viewing thumbnail captions, and RAW file view format.

1. Select [Options] from the tool menu in the PENTAX PHOTO Browser window. Or, click the button on the toolbar.

The [Options] dialog box appears.
<table>
<thead>
<tr>
<th>Item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Folder at start</td>
<td>From the following, select the folder to open when starting the program. Last folder used: This opens the folder that was open when PENTAX PHOTO Browser was last closed. Desktop: This opens the desktop. Set Folder: Click the [Browse] button and specify a folder.</td>
</tr>
<tr>
<td>Browser window size at start</td>
<td>From the following, select the window size when starting the program. Last size used: This starts the program with the window size when PENTAX PHOTO Browser was last closed. Full size: This starts the program with the window size maximized. Set size: This specifies the width and height of the window size used when starting the program.</td>
</tr>
<tr>
<td>Main image window size</td>
<td>From the following, select the main image window size. Last size specified: This uses the view size last used for the main image window. Full size: This starts the program with the main image window size maximized. Set size: This specifies the width and height of the main image window size. Default: The main image window view uses the default size.</td>
</tr>
<tr>
<td>Thumbnail caption order</td>
<td>This sets the thumbnail caption view order by [Date] or by [Time].</td>
</tr>
<tr>
<td>Main RAW file image</td>
<td>This sets whether to use [Simple display] or [Auto RAW display] when viewing RAW image data in the main image window. When selecting [Auto RAW display], also specify the processing ratio.</td>
</tr>
<tr>
<td>Size</td>
<td>Select the processing ratio for Auto RAW display from [Life Size], [1:2], or [1:4]. When emphasizing image quality, select [Life Size]. When emphasizing speed, select [1:4].</td>
</tr>
</tbody>
</table>

2 After making your selections, click [OK].

The options are set and the Options dialog box is closed.
Managing image files and folders

Moving / Copying image files

1. In the PENTAX PHOTO Browser window thumbnail pane, select the thumbnail image to move or copy.

2. Select [Cut] or [Copy] from the [Edit(E)] menu. Or, click the and buttons on the toolbar.

3. Specify the destination folder for moving or copying in the tree view.
Select [Paste] from the [Edit(E)] menu. Or, on the toolbar, click the button.
The image file is moved or copied to the specified folder.

- You can also move an image by dragging and dropping a thumbnail image to the destination folder. To copy, hold down the Ctrl key while you drag and drop the file.
- The same operation can also move or copy a folder. In the tree view, specify the folder to move or copy. The specified folder is moved or copied into the destination folder.
Deleting image files / folders

1. In the PENTAX PHOTO Browser window thumbnail pane, select the thumbnail image to delete. Or, select the folder to delete in the tree view.

2. Select [Delete Image File] or [Delete Folder] from the File menu. Or, on the toolbar, click the 

   button.

   A delete confirmation screen appears.

3. Click [Yes].

The image file or folder is deleted.
Changing image file / folder names

1 In the PENTAX PHOTO Browser window thumbnail pane, select the thumbnail image to be renamed. Or, select the folder to be renamed in the tree view.

2 Select [Change Image File Name] or [Change Folder Name] from the File menu.

When you select [Change Image File Name], the thumbnail image file name area will be ready for input.
When you select [Change Folder Name], the folder name area in the tree view will be ready for input.

3 Input the file or folder name.
The image file or folder is renamed.
Create a New Folder

1. In the PENTAX PHOTO Browser window tree view, select the folder where a new folder will be created.

2. Select [Create New Folder] from the File menu.

A “New Folder” is created under the specified folder. To input a folder name, select the created [New Folder], and then select Folder Name in the (File) menu and input the folder name.
Displaying properties of image files / folders

1. In the PENTAX PHOTO Browser window thumbnail pane, select the thumbnail image for showing properties. Or, select the folder for showing properties in the tree view.

2. Select [Properties] from the File menu.
   The properties window appears.
3 Confirm the content, and input information as needed.

4 Click [OK].

The properties window is closed.
PENTAX PHOTO Laboratory is software for color separation processing and other processing of CCD RAW image data recorded in a PENTAX digital camera dedicated format. After this processing, the images can be viewed on commercially available image viewing and editing software.

This section describes opening and closing PENTAX PHOTO Laboratory, viewing the PENTAX PHOTO Laboratory window and explains its functions.

**Opening the PENTAX PHOTO Laboratory**

**For Windows**

1. **Select the [Start Menu] in the desktop screen.**

2. **Select [PENTAX PHOTO Laboratory] from the [PENTAX Digital Camera Utility] in the program menu.**

PENTAX PHOTO Laboratory is opened, and the PENTAX PHOTO Laboratory window appears.
For Macintosh


2. Double-click the [PENTAX PHOTO Laboratory] program icon.

   PENTAX PHOTO Laboratory is opened, and the PENTAX PHOTO Laboratory window appears.

Closing the PENTAX PHOTO Laboratory

Click the [Close] button in the PENTAX PHOTO Laboratory window.

Memo

- To open [PENTAX PHOTO Laboratory], you must first install [PENTAX PHOTO Browser] on your computer. See "Installing the PENTAX PHOTO Browser" on P.6 for the installation procedure.
- [PENTAX PHOTO Laboratory] can also be started from within [PENTAX PHOTO Browser]. P.19
About the PENTAX PHOTO Laboratory window

This section explains the PENTAX PHOTO Laboratory window layout, names, and functions.
This executes functions or sets various settings of the PENTAX PHOTO Laboratory.

<table>
<thead>
<tr>
<th>Number</th>
<th>Icon (button)</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Open</td>
<td>This selects the image file for processing in [PENTAX PHOTO Laboratory]. This cannot be used when [PENTAX PHOTO Laboratory] was started within the [PENTAX PHOTO Browser] window. (Only applies when the software is started as standalone.) P.49</td>
</tr>
<tr>
<td>2</td>
<td>Save</td>
<td>This performs RAW image data processing and saves it with the specified format. The available save formats are JPEG, TIFF, and TIFF16. Select the save format using the appropriate toolbar button. P.55</td>
</tr>
<tr>
<td>3</td>
<td>Full Auto Processing</td>
<td>Performs color separation processing using the processing conditions set in the RAW file.</td>
</tr>
<tr>
<td>4</td>
<td>Custom Processing</td>
<td>This performs color separation processing using the processing condition settings specified by the user. When you click the [Custom Processing] button, a RAW processing conditions setting panel appears at the bottom of the PENTAX PHOTO Laboratory window. When you click each item (White Balance, Tone Curve / Histogram, Sensitivity / Contrast / Saturation / Sharpness), each setting panel is displayed. Set each item in its setting panel. P.51</td>
</tr>
<tr>
<td>5</td>
<td>Save Adjustment</td>
<td>This saves the processing conditions set in [Custom Processing] as an adjustment file.</td>
</tr>
<tr>
<td>Number</td>
<td>Icon (button)</td>
<td>Content</td>
</tr>
<tr>
<td>--------</td>
<td>--------------</td>
<td>---------</td>
</tr>
<tr>
<td>6</td>
<td>Recall</td>
<td>Recalls a saved adjustment file.</td>
</tr>
<tr>
<td></td>
<td>Adjustment</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>JPEG</td>
<td>Sets the save format for the processed image file as JPEG format. P.55</td>
</tr>
<tr>
<td></td>
<td>Save as JPEG</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>TIFF</td>
<td>Sets the save format for the processed image file as TIFF format. P.55</td>
</tr>
<tr>
<td></td>
<td>Save as TIFF8 bit</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>TIFF</td>
<td>Sets the save format for the processed image file as TIFF16 format. P.55</td>
</tr>
<tr>
<td></td>
<td>Save as TIFF16 bit</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Options</td>
<td>Changes PENTAX PHOTO Laboratory settings. P.56</td>
</tr>
<tr>
<td>11</td>
<td>Help</td>
<td>Displays the PDF manual.</td>
</tr>
<tr>
<td>12</td>
<td>Back</td>
<td>When multiple images are read, this will return to the immediately previous image.</td>
</tr>
<tr>
<td>13</td>
<td>Refresh</td>
<td>Click to apply RAW image processing conditions. This applies when the [Refresh] button has been set under Options to refresh the preview.</td>
</tr>
<tr>
<td>14</td>
<td>Forward</td>
<td>When multiple images are selected, this will proceed to the next image.</td>
</tr>
</tbody>
</table>
Viewing Images

1. Click the button in the PENTAX PHOTO Laboratory window.

   The Open File dialog box appears.

2. Specify the file name for a RAW image file and click [Open].

   A RAW image appears in the PENTAX PHOTO Laboratory window.

Multiple image files can be read if you select multiple images. When doing so, click the and buttons on the toolbar to preview the image you want.
• When starting the PENTAX PHOTO Laboratory from the PENTAX PHOTO Browser, use the following methods for viewing image files.
  • Select RAW image files in the PENTAX PHOTO Browser, then start the PENTAX PHOTO Laboratory.
    (RAW image files can also be selected in the PENTAX Photo Browser after the PENTAX PHOTO Laboratory has been started.)
  • To select multiple image files in the PENTAX PHOTO Browser, press and hold the Ctrl key as you left click on thumbnail images you want to select.
Setting RAW image data processing conditions

1 Click the [Custom Processing] button in the PENTAX PHOTO Laboratory window.

A RAW processing conditions settings panel appears at the bottom of the PENTAX PHOTO Laboratory window.

2 Click [White balance], [Tone curve / Histogram], or [Sensitivity / Contrast / Saturation / Sharpness].

The appropriate setting panels appear.

3 Enter settings in each setting panel.

The settings are reflected in the preview screen. There are two ways to reflect the settings. Use the button to set the method.  P.56

• Reflect in real time immediately after setting
• Reflect when clicking the button on the toolbar
- When setting the white balance

<table>
<thead>
<tr>
<th>Item</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select White Balance</td>
<td>Select from the following:</td>
</tr>
<tr>
<td>Camera setting</td>
<td>Apply the white balance setting used on your camera.</td>
</tr>
<tr>
<td>Override</td>
<td>Use White Balance Setting to select the white balance to apply. Select from [Daylight], [Cloudy], [Shade], [Daylight fluorescent light], [White fluorescent light], [Neutral white fluorescent light], [Tungsten light], or [Flash].</td>
</tr>
<tr>
<td>Gray point setting</td>
<td>Sets the gray point. Set the gray point by clicking on the part of the preview image you wish to make gray.</td>
</tr>
</tbody>
</table>
• When setting the Tone curve / Histogram

<table>
<thead>
<tr>
<th>Item</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tone curve</td>
<td>The relationship between the input level and output level is set using a graph (Up to 16 points.) If the graph is left clicked, the line on the graph moves to that spot and the point can be set. The point can be released by right clicking (Windows only).</td>
</tr>
<tr>
<td>Histogram (Luminance)</td>
<td>Displays the light distribution when combining RGB.</td>
</tr>
<tr>
<td>Histogram (R)</td>
<td>Displays the light distribution for R (Red).</td>
</tr>
<tr>
<td>Histogram (G)</td>
<td>Displays the light distribution for G (Green).</td>
</tr>
<tr>
<td>Histogram (B)</td>
<td>Displays the light distribution for B (Blue).</td>
</tr>
<tr>
<td>Reset</td>
<td>Deletes the tone curve settings, and returns to a straight line.</td>
</tr>
</tbody>
</table>

*To display the Histogram, press the [Select screen] pull down to switch the display.*
- When setting the Sensitivity / Contrast / Saturation / Sharpness

<table>
<thead>
<tr>
<th>Item</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sensitivity</td>
<td>Adjusts the sensitivity of development processing.</td>
</tr>
<tr>
<td></td>
<td>+ : The image becomes brighter.</td>
</tr>
<tr>
<td></td>
<td>- : The image becomes darker.</td>
</tr>
<tr>
<td>Contrast</td>
<td>Adjusts the contrast between light and shadow.</td>
</tr>
<tr>
<td></td>
<td>+ : Increases contrast between light and shadow.</td>
</tr>
<tr>
<td></td>
<td>- : Decreases contrast between light and shadow.</td>
</tr>
<tr>
<td>Saturation</td>
<td>Adjusts the strength of the colors after RAW data development.</td>
</tr>
<tr>
<td></td>
<td>+ : The colors become stronger.</td>
</tr>
<tr>
<td></td>
<td>- : The colors become weaker.</td>
</tr>
<tr>
<td>Sharpness</td>
<td>Adjusts the sharpness of the edges.</td>
</tr>
<tr>
<td></td>
<td>+ : Image contour is enhanced.</td>
</tr>
<tr>
<td></td>
<td>- : Image contour is softened.</td>
</tr>
</tbody>
</table>
Saving image files

You can save the image files which have been Full Auto processed or Custom processed. When saving, specify the saving format. You can specify JPEG format, TIFF format, or TIFF16 format.

1. **Set the save format by clicking the [JPEG], [TIFF8 bit], or [TIFF16 bit] button on the toolbar.**

2. **Click [Save] on the toolbar.**
   The “Save as” dialog box appears.

3. **Specify the file name and saving location and click [Save].**
   The image file is saved.

**Memo**
When PENTAX PHOTO Laboratory is opened from PENTAX PHOTO Browser, the main image window is displayed for confirmation after the image is saved.
Changing the PENTAX PHOTO Laboratory settings

1 Click [Options] on the toolbar.

The [Options] dialog box appears.

```
<table>
<thead>
<tr>
<th>Item</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color Space</td>
<td>Select the Color space from [s RGB] or [Adobe RGB]. sRGB is a standard color space value for generic PC monitors. AdobeRGB is a color space that includes colors that can be printed, but not displayed properly on a monitor for computer.</td>
</tr>
<tr>
<td>Refresh Preview</td>
<td>[Real time]: Set this to apply processing conditions to the Preview image upon each change made to [Custom Processing] settings. [Refresh button]: Set this to apply processing conditions to the Preview image after all changes are made to [Custom Processing] settings, upon clicking the Refresh button.</td>
</tr>
<tr>
<td>Saving method when processing multiple images</td>
<td>Select the saving method when processing multiple images, from the following choices: [Save with Original File + extension], [Save with Numbered files] and [Save One at a time].</td>
</tr>
</tbody>
</table>
```

2 After setting each item, click [OK].

The options are set, and the dialog box is closed.
CSV format
This data format lists recording fields, and segregates them with a comma (,). Generally, character strings come as double quotation marks in CSV format. Some software include data input and output functions in CSV format as part of a multipurpose format.

Exif-TIFF format
Exif stands for Exchangeable Image File Format. This image file format is based on the TIFF image data format, and allows thumbnail images and image properties to be embedded into the data. Software that does not support this format processes the image as a regular TIFF image.

Exif-JPEG format
Exif stands for Exchangeable Image File Format. This image file format is based on the JPEG image data format, and allows thumbnail images and image properties to be embedded into the data. Software that does not support this format processes the image as a regular JPEG image.

CCD RAW data
CCD stands for Charge Coupled Device. A semiconductor device that converts optical information into electrical signals. RAW image data is raw data recorded from CCD output. This data can be transferred to a PC, and manipulated into image data with unique settings such as JPEG and TIFF using specialized software.

JPEG
An image compression format. Select INGPE2_C (S. Fine), INGPE2_D (Fine), or INGPE2_E (Economy) for image quality, and the image is saved in JPEG format. Although the image quality deteriorates a little, more images can be saved in the same space.

TIFF
A file format for saving image data. The image is not compressed making the file size large, but no deterioration of image quality occurs.
TIFF16
Although TIFF images are usually 8 bit, this is 16 bit TIFF. One 8 bit pixel can reproduce 256 colors. More computations are required when image processing as the dynamic range is larger.

sRGB (standard RGB)
An international color space standard defined by IEC (International Electrotechnical Commission). This is specified as a standard color space for generic PC monitors and Exif.

AdobeRGB
This color space is recommended for commercial printing and document creation by Adobe Systems (US). Its color reproduction range is larger than sRGB, and adequately covers the color reproduction range for printing. Therefore, color data only reproducible on a printer are not lost when editing on the PC. Note: using it with unsupported software causes the colors to appear faint.
PENTAX Corporation 2-36-9, Maeno-cho, Itabashi-ku, Tokyo 174-8639, JAPAN
(http://www.pentax.co.jp/)
PENTAX Europe GmbH (European Headquarters) Julius-Vosseler-Strasse, 104, 22527 Hamburg, GERMANY
(HQ - http://www.pentaxeurope.com)
(Germany - http://www.pentax.de)
PENTAX U.K. Limited PENTAX House, Heron Drive, Langley, Slough, Berks SL3 8PN, U.K.
(http://www.pentax.co.uk)
PENTAX France S.A.S. 12/14, rue Jean Poulmarch, 95106 Argenteuil Cedex, FRANCE
PENTAX Benelux B.V. (for Netherlands) Spinveld 25, 4815 HR Breda, NETHERLANDS
(http://www.pentax.nl)
(for Belgium & Luxembourg) Weiveldaan 3-5, 1930 Zaventem, BELGIUM
(http://www.pentax.be)
PENTAX (Schweiz) AG Widenholzstrasse 1 Postfach 367 8305 Dietlikon, SWITZERLAND (http://www.pentax.ch)
PENTAX Scandinavia AB P.O. Box 650, 75127 Uppsala, SWEDEN
(http://www.pentax.se)
PENTAX U.S.A., Inc 600 12th Street, Suite 300 Golden, Colorado 80401 U.S.A.
(http://www.pentax.com)
PENTAX Canada Inc. 3131 Universal Drive, Mississauga, Ontario L4X 2E5, CANADA
(http://www.pentaxcanada.ca)

• Printed on recycled paper
• Specifications and external dimensions are subject to change without notice.